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USE AND DISTRIBUTION NOTICE

e Santa Clara County RACES authorization is granted to use and
duplicate this material as-is as long as this page and the
copyright notices on each page are included, acknowledging
Santa Clara County ARES/RACES as the holder of the
copyright.

e Permission is granted to adapt this presentation to your
needs as long as you acknowledge our copyright and include a
note similar to "adapted with permission from Santa Clara
County ARES/RACES”

e For additional information on training or any of our programs
send an email to: info@scc-ares-races.org
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HOUSEKEEPING

e Introductions

e Pen/pencil & paper

e Cell phones

e Side conversations

e Questions

e Corrected Handouts

e Breaks

e Restrooms (code: 9033)
e |n case of emergency

e No wandering or exploring
other areas of the building.
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Overview: Packet Classes

Packet Type lll, Part A ﬂacket Type lll, Part B \
e Role of the Packet Operator e Packet Operations
e Packet Network Overview e Diagnosing Setup Problems

Selecting a BBS
Creating Messages
Event Documentation
Productivity Hints
Exercises

Packet Type Ill, Part A+ \ /
e Packet Operations Self-Paced

Exercise workbook

Packet Network Components
Packet Station HW & SW
Accessing the Network
Standard Workflow

Packet Type Il: Advanced Techniques, such as County EOC Packet
Station Setup & Operations, Operating without Outpost.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 3
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Learning Objectives

At the end of this class, you should know how to:
e Verify the setup of an existing packet station
e Select a BBS and connect to it

e (Create a message with Outpost and PackltForms
— Properly format the subject line
— Send a proper check-in message

e Retrieve SCCo notices and send local notices
e Produce event documentation for archiving
e Conduct packet messaging field operations

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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Fictitious Examples

e We use fictitious call signs in this presentation to avoid SPAM

e WG6XRL4: Herman Munster

y WEXRL4

e
Herman Munster & PR
1313 Mackingbird Lane « s
Camelot, New Jersey USA X

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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GLASBERGEAN == A
I couldn't do my packet homework because
my packet station has a virus.

PACKET IIA HOMEWORK AFTER-ACTION

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 6
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Type lll Part A Homework observations

e For the most part, everyone did quite well.

e Held 2 office hours, about 6 folks showed up with various
guestions from on the homework and BBS access.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 7
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Type lll Part A Homework observations

e Messages from the internet ...

_R_Exercise 4.5.7a, (PM:868)

e These look like manual messages e ,
created on home email accounts Pt [l Baply Eo ]| Lok § Elast

Private Message
Bbs: W1XSC-1
e What happened to the Message ID?! From: )@yahoo.com

To: lostst@w1ixscamprorg
Subject _R_Exercise 4.5.7a, "Il

e [fyouintend to originate a message Exercise 4.5.7a,
from the Internet into the Packet-world,
then as a best practice, create and used your own Message ID sequence.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 8

8

© Copyright 2023 Santa Clara County ARES®/RACES. All rights reserved. 9



Packet Operator Type Ill Part B

10/2/2023

— Bottom Line:

e The cost of HTML Text email.

e Several class members saw
first hand turning a 40
character message...

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

File Message  Help

obermail@att.net
html vs. text
J Oberhofer

Sending message in html.

Jim
KN6PE

P .

e ...into a 2085 character message

— More than a 50X size increase in the
text to be transmitted!

— Both plain text and HTML text are sent
in the same message.

Be careful sending messages into the
packet system from email accts!

— And, don’t forget that Subject Line rules
apply here as well.

Type lll Part A Homework observations

= OB S

htmi
Q Tell me what you want to do
knépe@wixsc.ampr.org’ J (Jberha!e'i

B htmi vs. text (PM:900)

File Edit View Actions Windows Help

Print | Reply = ReplytoAll Fumarul Archive | Delete | Close 3| AlA

Private Message
Bbs: NV1XSC-1 Rec'd: 8/10/2023 14:13 Sent 8/10/2023 14:13
Local Msg ID: 6PE-2341P

From  obermail@attnet
To: knBpe@w1xsc.amprorg; knBpe@arri.net
Subject  html vs_ text
This is a multipart message in MIME format. ~
~=——--= NextPart_000_003C_01DSCB24.CTFDDE0O
Content-Type: text/plain;
charsec="us-ascii®

Content-Transfer-Encoding: 7bit

Sending message in html.

Fim I
EKNEPE
------= NextPart_000_003C_01DSCE%4.CTFDDEOD
Content-Type: text/html;

charsec="us-ascii®
Content-Transfer-Encoding: quoted-printable
<html xmlns:v=3D"urn:schemas-microsoft-com:vml" =
xmlns:o=3D"urn:schemas-microsoft—com:office:office” =
xmlns:w=3D"urn:schemas-microsoft-com:office:word” =
xmlns:m=3D"http://schemas.microsoft.com/office/2004/12/omml"™ =
xmlns=3D"http://www.w3.0rg/TR/REC-html40"><head><META =
HTITP-EQUIV=3D"Content-Type"™ CONTENT=3D"text/html; =
charset=3Dus-ascii"><meta name=3DGenerator content=
3D"Microsoft Word 15 =
(filtered medium)"><style><!--
/* Font Definitions */
@font-face

{font-family:"Cambria Math";

panose-1:2 4 5 3 5 4 6 3 2 4;}
@font-face

{font-family:Calibri;

panose-1:2 15 52 22 4 3 2 4;) v

2,085
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7
PACKET FIELD DEPLOYMENT

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 10
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Packet 3A recap

Packet Network Overview and Components
Packet Station HW & SW

Accessing the network g ™ ——:-.—,I:.,-'éf __{F—
Standard workflow > < AR
o PN e -
Working with messages - = S 3 Y -
—— - . e - p—

10/2/2023

e Customizing message handling
e Miscellaneous Outpost settings
e Localizing packet

Copyright 2023 Santa Clara County ARES/RACES. All rights reserve d.

How does this all fit together during a field deployment?
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Thinking in terms of a Packet Field Deployment

1. First Shift... when assigned to start up a station

2. Initial station setup... equipment check-out

3. Packet Operations... managing the message flow

4. Incoming Shift Change... if you are relieving someone else
5. Outgoing Shift Change... if you are being relieved

6. Securing Operations... when directed to shut down

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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Packet Field Deployment Process

1. First Shift: Establishing a packet station

Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

Check into the assigned voice net before you leave your car.
Start an ICS 309 Comm Log for the voice net.

Make an ICS 214 Unit log entry.
Sign in on the site’s ICS 211 Check-in sheet.
Find the supervisor and inform them of your arrival.

Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist. You need to know:

Band and frequency
Primary and secondary packet addresses for any
preferred destinations

Find and establish the workspace to set up packet operations.

1. First Shift
;
Z;
3.
4
R -
v/ s
a. Supervisor's Name
b. Activation Number
c. Operational Period
d. ICS Location
e. Your Tactical Call and Message ID Prefix
f. BBStouse
g.
h.
7.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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v

v

8.

9.

10.

11

2. Initial setup
Packet Field Deployment Process

2. Initial setup: Equipment check-out

Find, assess, and setup the packet radio equipment
(see Section 3, Packet Startup Procedure)

Confirm or set your User Identification (FCC Call Sign) and
Tactical Call for the assigned agency.

Check settings before transmitting:
Correct BBS in Outpost
Correct Interface in Outpost
Correct radio frequency

Begin packet operations. Make ICS 214 Unit log entry.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 14
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3. Packet Operations

Packet Field Deployment Process

3. Packet Operations: Managing the message flow
12. Download all notices to ensure you have the latest; read them.

13. Set up a folder named “SCC Notices” (Tools > General Settings,
Startup tab) and move all notices to this folder.

14. Send a test message to yourself to confirm you can create, send
to, and receive from the assigned BBS.

15. Create a Check-In message to your assigned agency using your
Tactical call sign (see Section 5 Check-in, Check-out Message).

16. Send, receive, log and process packet messages. To only send a
message as soon as it is created, use Actions > Send Only

17. Manually initiate an Outpost Send/Receive at least every 10
minutes.

18. If a message was not acknowledged:

a. Check the message address and BBS
b. Resend the message if needed
c. Let your supervisor know

... more

‘\ ‘\ |\ ‘\ ‘\ ‘\\

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 15
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v

3. Packet Operations (continued)
Packet Field Deployment Process

3. Packet Operations: Managing the message flow

19.
20.
21.
2.

If new notices are retrieved, follow any new instructions.
Maintain voice radio contact on the designated voice net.
Make ICS 214 Unit log entries as appropriate.

Report any issues or problems to your supervisor in person or
over the voice net (if remote).

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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4. Incoming Shift Change

Packet Field Deployment Process

4. Incoming Shift Change: If you are relieving someone else, do the following:

23. Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

24. Sign in on the local ICS 211 Check-in sheet.
25. Find the supervisor and inform them of your arrival.

26. Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist.

27. Find the person you are relieving and receive a shift change
briefing (see Shift Change Information below).

v 28. Make packet system updates — Station ID, Tactical Call, etc.
29. Make all relevant shift change entries in your ICS 214 Unit log.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 17
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v
/

31.
32.

33.
34.

35.

36.
37.
38.

5. Outgoing Shift Change

Packet Field Deployment Process

5. Outgoing Shift Change: If you are being relieved, do the following:
30.

When contacted by your replacement, provide a shift change
briefing (see Shift Change Information below).

Generate and sign a packet ICS 309 Comm Log for your shift.

Generate all event packet documentation for your shift and deliver
as instructed (see Section 10 Archiving Event Documentation).

Turn over all assigned equipment to your replacement.

Find your supervisor and inform them of the shift change and your
departure.

Make the appropriate shift change entries in your ICS 214 Unit
log. Complete and sign the form.

Turn in all paperwork to your supervisor.
Sign out on the site’s ICS 211 Check-in sheet.

Check into the Resource Net. Inform Net Control what you plan to
do (go home, return to EOC, etc.).

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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TS N

41.
42.

43.
. Shut down and pack up all assigned equipment.
45.
46.
47.

6. Securing Operations
Packet Field Deployment Process
6. Securing Operations: when directed to shut down, do the following:

39.
40.

Get permission from your supervisor to shut down.

Create a text Check-Out message to your assigned agency using
your Tactical Call sign (see Section 6 Check-in, Check-out
Message).

Generate and sign a packet ICS 309 Comm Log for your shift.

Generate all event packet documentation for your shift and deliver
as instructed (see Section 8 Archiving Event Documentation).

Complete and sign your ICS 214 Unit log.

Turn in all paperwork to your supervisor.
Sign out on the site’s ICS 211 Check-in sheet.
Check out of the assigned voice Net and check in with the

Resource Net. Inform Net Control what you plan to do or where
you will go.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Amateur Packet Radio

Field Reference, Type Il Amateur Packet Radio
Field Reference, Type lll

What is it
For SCCo RACES Responders
e Provides a reminder (job aid) for F
how to perform tasks that need September 2023
to occur during a packet field
deployment.

e Helps ensure task consistency,
completeness, and operational
alignment with SCCo RACES
policies and procedures.

What it is not

e the only source of information on
which you should rely.

e an official SCCo RACES
deliverable.

)

b

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 20
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Initial Setup — Scenario

e Upon arrival at your assignment, your supervisor explains that
someone from the local ham club tried to get the packet
station working. They were unsuccessful and had to leave.

e He takes you over to the hardware:

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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No Problem! ... Right?

Assembling and configuring a packet station is simple

And problems are rare, especially for regular users

But at some point ...
... especially when using someone else’s gear,
... you may face at least one of these problems

Use a logical process to find and resolve problems

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 22
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Verifying Packet Station Readiness

1. Connections
2. Initial power-up
3. Equipment settings

4. Application settings

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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1. Connections

%Fuse1 Fuse2
Power Supply
PC/Laptop TNC Radio
e Comm Port, or e Serial (or USB) cable e Antenna coax connected
e USB portand a e Custom TNC/radio cable e Power cable, fused, to
USB-to-Serial adaptor e Power cable, fused, to power supply or battery
e Windows USB Driver power supply or battery — Fuse2 = 15-20A (typical)

— Fusel = 1A (typical)

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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1. Connections — What You May See

Here is what you see when you find the hardware...

Do you
have an
adapter?

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 25
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1. Connections — After Correct Assembly

You’ve straightened out the hardware and cabling

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 26

26

© Copyright 2023 Santa Clara County ARES®/RACES. All rights reserved. 27



Packet Operator Type Ill Part B

10/2/2023

2. Initial Power-up

power adaptor is
plugged in

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

$ Fuse1 Fuse2
Power Supply
PC/Laptop TNC Radio
e Laptop boots up e Apply power e Apply power
e Battery charged, or e Power LED lights up e Radio turns on correctly

27
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2. Initial Power-up - TNC

e |F: TNC power cable is plugged directly into a RigRunner

RiGrunner 4005

e AND: TNC’s power light is on

— You may or may not notice that it appears a little dimmer than usual.

e BUT: No response from the TNC via a serial connection;
it behaves like it’s turned off.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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2. Initial Power-up - TNC

e THEN: It probably IS off!

e Check the RigRunner. Is there a red light on behind the fuse?
— Replace the fuse
— RigRunner lights an LED behind the fuse when the fuse is burned out
— But the current needed to power the fuse LED is just barely enough to
light the power light on the TNC (dimly)!
e Or, try another port on the RigRunner.
— Your model may not have an LED light or it may not be working

e Or, try another power cord

e Avoid blowing a fuse:

— ALWAYS plug the power cord into the TNC first, then into the power
source.

— This avoids the chance of the TNC power connector plug tip touching the
TNC chassis, thereby shorting positive to ground, and blowing the fuse

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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3. Equipment settings

?Fuse1 Fuse2
Power Supply
PC/Laptop Settings TNC Settings Radio Settings
e Terminal Program: e Comm Port Settings e Correct frequency
Comm Port Setting = 9600 baud * No Tone
— Com Port # e Other KPC-3s default e No offset
— 9600 baud to 8-N-1 e Squelch open
— 8 data bits e Carrier Detect settings e High power
— No parity — INTFACE TERMINAL e Correct side is selected
— 1 stop bit — CD SOFTWARE for packet
— RTS/CTS flow control

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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3. Equipment settings — TNC

What could go wrong?

Meaning, what are the symptoms?

Can’t find the Com Port for my USB-Serial adaptor
TNC is stuck in Autobaud routine

When | type something, | see garbled text

Can’t communicate with the TNC

vk W

Wrong audio output level

If you are stuck here and cannot ‘talk’ to the TNC, do not even
try to proceed to the next step!

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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3. Equipment settings — TNC
USB-Serial adaptor problems/missing PC Com Port

Most TNCs use: 9600 baud, 8-N-1, RTS/CTS

Outpost:
. Setup > Interfaces ... > [Choose TNC] > Comm Port
Windows:
1% Device setup for XSC_Kantronics_KPC3-Plus X
W ; -
i+ Device Manager d Type | Prompts | TNG Cmds | initCmds  Comm Port ] AGWPE | Telnet |
File Action View Help Comm Port Settings Ipserial:
= = HE . = Setup > Comm Port Settings
. - - = "’ZJ
[P I?lsplay adapters o ol & On 1= Comm Port Setup x
3 i Firmware IQBDD J
> [ Human Interface Devices » Flow Control e
> *@ IDE ATA/ATAPI controllers ' : o . =
o . . Connection Preferences ane MG oaed
=fx Imaging devices . P
Data Bits: | 2 - .
> E2 Keyboards :J & RTS/ACTS |9600 =l ' &
@ Mice and other pointing devices Parity: [None =
> [ Monitors Connection Preferences Flows Control
3 Network adapt Stop Bit: | 4 - [rata Bits: |8
I Network adapters 57 ~ Nore
> = s
o a Ports (COM & LPT) Parity: Hahe - {* RTS/CTS
- E USB Serial Port (COM3) Stap Bits: m
> [ Print queues
3 n Processors
> WY Security devices
B Ssoftware devices 0K
| Sound, video and game controller:
> & Storage controllers
> Em@ System devices v
ak. Cancel
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 32
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3. Equipment settings — TNC
KPC-3’s Autobaud Routine

e With everything properly connected and powered on, you might see this...

Ipserial with Outpost

File Edit Setup Jools Help

Disconnactl Start Logaing | Al A

PRESS (*) TO SET BAUD RATEb
PRESS (*) TO SET BAUD RATEb

P CE th€] €€€exii<dEx<] €oex<] = €a"£ ~
P CE #PB€] e€€€€ExiEx<yEx<€E] x<x€ €3£0 3 301377

PRESS (*) TO SET BAUD RATEb P CE fbe]scssesssseexusx<dxaxisesx<] tx<]=="=0]3"]~~£][ 30 As£

PRESS (*) TO SET BAUD RATEb P CE }Be] ccccceceeexicoex<] pee ™ £

PRESS (*) TO SET BAUD RATEb P CE }Be] seccexii<8ex<] €E=€"€3£0 3 3a°f

PRESS (*) TO SET BAUD RATEb P CE #B€] sececceceeexic] x<g€€ex<] =£7€0] 37"

PRESS (*) TO SET BAUD RATEb P CE iBe]ssssesessexu<dex<]€osx<] tx<se<] x<=="€3£0 3 3

PRESS (*) TO SET BAUD RATEb P CE 3}Be] scseccesecececeeeeexii<] €x<[ sxe~€] 3] Ae£

PRESS (*) TO SET BAUD RATEb P CE }Be] cescceexttx<yex<cAtx<dxaxhesex<]ac~<]3~"] ~~£1] 30 A=t

PRESS (*) TO SET BAUD RATEb P CE 3}B€] €€€€€€exuex<yEx<ee€] x<e€ex<] v

Connected to the TNC Sefttings: 9600,N,8,1 on Comm Port 10, STD TNC 00:10:32

e Thisis the KPC-3 Autobaud routine that assures that the KPC-3 Plus baud is the same
as that for whatever communication software you are using.

e AUTOBAUD sends and resends the message “PRESS (*) TO SET BAUD” at one
baud after another.

e When the KPC-3 baud matches that of your terminal program, you can read the text.
e When the two bauds do not match, the message appears garbled, if it appears at all.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 33
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3. Equipment settings — TNC
KPC-3’s Autobaud Routine

e WHEN does this occur:
— The first time your KPC-3 Plus is ever used (from the factory)
— Dead TNC memory battery
— User performs a hard reset with the RESTORE DEFAULT command

e HOW to fix:

— Getready... when you clearly see the PRESS (*) TO SET BAUD RATE
text, immediately press the “*” key.

— Then, enter the following commands:

ENTER YOUR CALLSIGN=> W6XRL4 (your call sign or tactical call)
cmd: INTFACE TERMINAL (enables the full TNC command set)
cmd: CD SOFTWARE (TNC Carrier Detect is performed in

software; lets you keep the radio
squelch open)

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 34
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3. Equipment settings — TNC

More on the TNC Carrier Detect command

e We recommend operating the packet station with the squelch
on the radio fully open (static/hiss all the time)
— Allows the TNC to receive the weakest of signals
— Unaffected by poorly chosen squelch level on the radio
e |f squelch is open and the TNC’s “Receive” light is on all the
time, then the TNC's carrier detect mode is incorrectly set

e After setting cD SOFTWARE, the TNC’s “Receive” light is only on
when packets are heard
e To do that for a Kantronics TNC, at the TNC Prompt, enter:
— cmd: CD SOFTWARE

— Carrier Detect performed by the TNC software, not squelch-dependent

— Other TNCs default to this option (Timewave) or have a different
command for this option; check your TNC manual

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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3. Equipment settings — TNC
Some more on the Intface Terminal command
Full Command Set

e After a hard reset, the Kantronics TNC puts you in NEWUSER mode.

e NEWUSER mode allows only the most basic commands. As a result,
you might see this:

Ipserial with Dutpost
File Edit Tools Help

Discornect | Stai Looding ] Al A

8
KANTRONICS PACKET COMMUMICATOR III VERSION 8.2
(C)y COPYRIGHT 1988-1997 BY KANTRONICS INC. ALL
RESEEVED.

DUPLICATION PROHIBITED WITHOUT PERMISSION OF KA
cmd:cd software

Command not awvailable in NEWUSEER mode

Oops, Wrong mode

cmd:

Caonnected ta the THC Settings: 9600,M.8,1 on Cornm Part 2 |oo:ooA?

To fix, at the cmd: prompt, you type:
cmd: INTFACE TERMINAL (allows all commands)
cmd: CD SOFTWARE

* Now, the RCV light only lights when the TNC hears packets

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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3. Equipment settings — TNC

G a rb I e d text E Ipserial with Outpost

File Edit Setup Tocls Help

Disconnect |

e What you see:
— Press a key, see garbled text.

e WHEN does this occur:

— TNC previously worked great!
— But someone changed the
program’s baud rate

e HOW to fix:
1. TNC baud is likely 9600

HB@R*IBg; [O¢ma_PI000 yyyyyyyyyisyyrry

Lettings: 2400,N,8,1 on Jomm Port 10, STD TNC
e

1

Connected to the TNC

E Ipserial with Outpost

File Edit Setup Jools Help

2. Change the program baud Disconnedt | |
Setup > Com Port Settings, HB@*R*IBg; [(Ocma_2 0] ¥yyyyyyyyUsyyrryyyMONITOR ON
change baud to 9600... —_—
3. Disconnect, Reconnect, press | |
any key.
4. Try other baud rates if this
does not fix it.

Connected to the TNC ettings: 9600,N,8,1 onjyomm Port 10, STD TNC 1
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e What you see:
— TNC previously worked great!

e WHEN might this occur:
— Someone or some program
put the TNC in KISS mode

e HOW to fix:
1. Start Ipserial
2. Verify the TNC Com Port
and baud rate

w

Tools > Kantronics Kiss Off
5. TNCis restored to TERMINAL
mode

.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved

Verify Com Port Connect, then

3. Equipment settings — TNC
Can’t communicate at all with the TNC (#1)

— The cable, USB drivers, and power are good, and no blown fuse
— But Press any key and | get no reply

E Ipserial with Outpost ==

File Edit Setup Jools Help

Disconnect

Get Com Port Settings from Outpost

C

Connected to the TNC , Settings: 9600,N,8,1 on Comm Port 10, STD TNC

e Create Message in Outpost
|<enter> <
Kantronics Kiss Off
Kantronics Host Off
AEA Kiss Off
KANTRONICS  ABAHostOff
(C) COPYR! PacComm Kiss Off INC. ALL R
DUPLICATIC View Outpost Data Directory JION OF KANT
cmd:
cmd: | Font
Reset Font
N —
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3. Equipment settings — TNC
Can’t communicate with the TNC (#2)

If you have a USB-Serial Adaptor, it is likely
to be a problem with the USB-Serial Adaptor Driver.

Windows Device Manager is next.
e Device Manager is a Microsoft Windows O/S tool.

e |t allows users to view and control the hardware attached to the
computer.

e When a piece of hardware is not working, the offending hardware is
highlighted for the user to deal with.

e Torun Device Manager...
1. Press Windows key + R key together to open a Run box.
2. Type devmgmt.msc, press OK. Device Manager opens.

3. Or, enter device manager in the Windows Search field on the task
bar... Device Manager opens.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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Can’t communicate with the T

e Find and expand the
Ports (COM & LPT) dialog.
e Don’tseeit? Then check:

— USB-Serial connector is
attached to the PC

— For KPC3+ USB, make sure
KPC3 is powered on

e Also, try
— View > Show hidden devices

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Windows Device Manager

an Device Manager

1t Device Manager File Action | View Help
File Action View Help € = | E| 8] Devices by type
= . [ Devices by connection
e m He & M Den201 Y
i Aud Devices by container
v &% Den20t8 @ Blue Resources by type
I} Audio inputs and outpu & con ’
0 8l h —— Resources by connection
uetoot e Disk
& Computer [ Disg |4 Show hidden devices
wa Disk drives & DVC )
& Display adapters ¥ rirm Customize..

== DVD/CD-ROM drives
! Firmware

s Human Interface Devices

=% Imaging devices
— Keyboards

@ Mice and other pointing

Bl Monitors

P Network adapters

@ Portable Devices

= Print queues

= Printers

O Processors

Wi Security devices

l* Software components
B Software devices

iy Sound, video and game
G Storage controllers
i System devices

¥ Universal Serial Bus cont

§ Universal Serial Bus devi
71 WSD Print Provider

W Human Interface Devices
=% Imaging devices
— Keyboards
@ Mice and other pointing devices
[ Monitors
P Network adapters
K7 Other devices
£ USB-SER!
M Portable Devices
~ [ Ports (COM &LPT)
! Arduino Uno (COM4)
W ELTIMA Virtual Serial Port (COM10)
! Keyspan USB Serial Port (COM7)

<

1

b

USB Serial Port (COM3)
USB Serial Port (COM6)

W USB Serial Port (COMB)
= Print queues

=

b

= Drintarc

Displays legacy devices a

Prolific USB-to-Serial Comm Port (COMS)
Prolific USB-to-Serial Comm Port (COM9)

40
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Windows Device Manager
Can’t communicate with the TNC

1. Find and expand Ports (COM & LPT) dialog.
2. You should see something like this...

- P . t - -
=L Frint queues ~ Print queues

3. You do not want to see anything like this...

Il These are not all the problems you might see.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved

B Portable Devices Portable Devices
« @ Ports (COM &LPT) Ofe L @ Ports (COM & LPT)
W Keyspan USB Serial Port (COM7) @ USB Serial Port (COM3)

v R Other devices Portable Devices
B4 USB-SER! «Ofee L @ Ports (COM & LPT)
B Portable Devices ¥ PL2303HXA PHASED OUT SINCE 2012
= Print queues = Print queues
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Yes, you have a problem... now what?
Can’t communicate with the TNC

e Troubleshooting USB-Serial driver problems is a
class by itself... we do not have time to cover it here.

e However, here are 5 (not all) things you can do:

1. Review the SCCo RACES USB-to-Serial Adapter page... Data Networking
> AX.25 over VHF > Equipment and Software > USB-to-Serial Adapter

2. Post your problem or questions to the packet email list. It is likely
there are SCC RACES packet ops who have encountered and solved
this problem before.

3. If you know the USB-Serial adaptor chipset, try searching,
downloading, and installing its Windows driver.

4. Buy yourself a new USB-Serial Adaptor, then label it, practice with it,
build confidence with it, put it in your packet kit, and deploy with it.

5. Lastly, if you have a bunch of old, unknown, or confirmed non-
working USB-Serial Adaptors in your junk box, then throw them out
NOW and save yourself from future headaches.
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3. Equipment settings — TNC
Wrong audio output level
e The TNC sets the audio output level (transmit drive audio) to your radio.
e The transmit drive level can be set from the command line, but it implies
you know to what value it should be set.
e While calibrating the drive level is beyond the scope of this course, being
able to view and set a previously determined value is in scope.
e Toview the currently set transmit drive level:
cmd : XMITLVL (xM for short command)
XMITLVL 100 (displays the value. Default=100, range is 0 to 255)
e To set the transmit drive level: BB 1serial with Outpo
cmd : XMITLVL 180 (example) File Edit Setup Jools Help
XMITLVL was 100 e
. . XMITLVL
e Most packet station owners will have the | aurrove 100 }
cmd : XM
XMITLVL written down. If you cannot find | Jaurzzve 100
. . . cmd : XMITLVL 180 b
it, see your Shift Supervisor. MITLVL was 100 {
cmd : XMITLVL
XMITLVL 180 ]
cmd:
L e st
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 43
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3. Equipment settings — Radio Frequency

e Use the correct frequency for your primary or secondary BBS

Call Sign | AX.25 ||User Access BBS-BBS | Location

WIXSC | W1XSC-1 | 145 750, 223 620, 433 570 Santa Clara Co Office Bldg (San Jose)
| W2xSC | W2XSC-1 145730, 223560, 433590 | | Crystal Peak (South County)

W3XSC | W3XSC-1 | 144310, 223 540, 433 450 Palo Alto

W4XSC | WAXSC-1 | 145690, 223 6007, 433.550 || 223.600 || Frazier Peak (above Milpitas)

http://www.scc-ares-races.org/fregs/packet-freqs.htmi

e The same information is available as a packet notice

Frequencies are in MHz.

Call Sign AX.25 Connect User Access BBS-BBS Forwarding
W1XSC W1XsC-1 145,750, 223.620, 433.570

W2XSC W2XSC-1 145.730, 223.560, 433.590

W3XSC W3XSC-1 144.310, 223.540, 433.450

W4XsC W4XSC-1 145,690, 223.€00%, 433.550 223.¢€00

%*223.600 is primarily for BBS forwarding; user access should be limited to
emergency/backup situations. Interference to/from other BBSs will be significant.
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3. Equipment settings — Radio Settings

e Everything is now on. You are supposed to use the W2XSC
BBS. But no packets are heard.

Voice side is set for

transmit <
g
Varies with radio & é’
settings & O

Frequency is
incorrect
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3. Equipment settings — Radio Settings

e You change the radio settings
— High Power

— Correct Frequency
— Squelch is open (BUSY)
— Correct side is set for packet (dual rcv/xmt radios, only)

e Some radios “force” packet to a particular side
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4. Application settings

$ Fuse1 Fuse2
Power Supply

Application Settings
e Station ID

e Tactical Call

e PCTime

* BBS

e TNC

e Other Outpost configurations

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Have you been
assigned a tactical
call sign?

Starting Outpost > Station ID

e You get to the Outpost Station ID screen....

[3 Station ID is W6XRL4 as XNDEQC

Identiﬂcation] BBS Logins | Signatures

Current Profile: |Dutpost
Legal

User Call Sigr: | WEXRLA

E

UserMame: {Harman Munster
Meszage [D Prefi g [3 Characters max)

Tactical

v Usze Tactical Call for all EBS interaction

Tactical Call Sigr: | XNDEQC

Is this your call sign,
name, initials?

Additional 10 Text: |}(anadu EOC
Meszage ID Prefix: [yip [3 Characters maw)

v Shaw this form on startup oK

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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Outpost PC Time Check

PC Time Check v3.5.0

Your PC's current time

Is the date and

Monday, 19-Sep-2022 ‘ 11:37:38 .
time correct?

Ifthe Date or Time is incorrect, then press Update and

setthe correct date and time for your PC.
1 Close |

Correct date and time is important!
It will be used in a variety of places.
Verify each time you start up.
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Checking the BBS and TNC settings

’;E Outpost Packet Message Manager - O X
File Edit S5etup Tools Forms  Actions  Help
Mew | Open | Archive Delete| Print | SendeeceivelF’roﬁle:loutpost j
] TI’E‘_‘{
U|ltype  |From | To | BBS | LocallD | Subject | Date/Time |  Size |
Qut Tray
Items: 0 Unread: 0 |WB><F|L4 asXNDEDC--XSC_WgSC-‘I --XSC_Kenwood_TM-D?‘IﬂK |UU:DD:DD|1B:DB:4‘I Y
... but you were assigned to W2XSC ... and you have a KPC-3+ TNC

o After setting the BBS and TNC, we are ready to go.

“/i Outpost Packet Message Manager - O X
File Edit S5etup Tools Forms  Actions  Help
Mew | Open | Archive | Delete | Print | Send/Receive | F’roﬁle:l Qutpost j
Folder List In Tray
U|ltype  |From | To | BBS | LocallD | Subject | Date/Time |  Size |
Qut Tray
Items: 0 Unread: 0 |WB><F|L4 az XMDEDC - X5C_W2HSC-1 - ®5C_Kantronics KPC3-Flus [Com3) |DD:DD:DD |1B:DS:42 A
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Best Test? — Press Send/Receive

File Edit Setup Tools Forms Actions Help /\
New | Open | Archive | Detete | F"n'titQ SendReceive

In Tray [ultwe [From  [To [ BBS |

Abort Session |

[lcPACTIME was OFF
cmd : STREAMEV OFF
. STREAMEV was OFF
You are talking to the TNC! —  |ccmd:sTrReamsw 500
STREAMSW was $7C

TNC prompt = cmd: omd: >
cmd: connect W2XsC-1
cmd:*** CONNECTED to W2XSC-1
[INOS-2.0k.1.xsc.1-IHM$]
'You have 0 messages.

You are talking to the BBS! — |%® >

0
JNOS BBS prompt = >’ 0> >

A XSCPERM

\l

<f

Retrieving Message List...

00:00:04

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Where should | connect?

SELECTING A BBS TO USE
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Selecting a BBS

e Santa Clara County ARES/RACES operates six BBSs
— FCC Call Signs: W1XSC, W2XSC, W3XSC, W4XSC, W5XSC, W6XSC

e Allsix are identical in function but operate independently to
maximize survivability during disasters

e All six have appropriate addresses for AX.25 packet radio, the
Internet, AMPRnet, BBS Network and NetROM

‘CaIISign ‘ AX.25 ‘InterneﬂAMPRnet ‘ BBS Network ‘NETA‘ROM Alias

‘ W1XSC ‘W1XSC-1 ‘ w1xsc.ampr.org ‘wfxsc.#nca.ca.usa.noam‘ XSCBB1

This information
is also available
as a packet
notice in the
Xxscperm area

‘ W2XSC ‘WZXSC-1 ‘ W2Xsc.ampr.org ‘w2xsc.#nca.ca.usa.noam ‘ XSCBB2

‘ W3XSC ‘WSXSC-1 ‘ w3xXsc.ampr.org ‘wstc.#nca.ca.usa.noam ‘ XSCBB3

‘ W4XSC ‘W4XSC-1 ‘ wéxsc.ampr.org ‘wﬁlxsc.#nca.ca.usa.noam ‘ XSCBB4

‘ W5XSC ‘W5X80-1 ‘ wbxsc.ampr.org ‘w5xsc.#nca.ca.usa.noam ‘ XSCBB5

‘ WEXSC ‘WBXSC-1 ‘ wbxsc.ampr.org ‘wﬁxsc.#nca.ca.usa.noam ‘ XSCBB6

https://www.scc-ares-races.org/freqs/packet-fregs.html
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Selecting a BBS

e Each city/agency has a “primary” and “secondary” BBS
— Minimizes hidden nodes
— Distributes load on our radio channels
— Eliminates BBS-to-BBS forwarding for messages within a single agency
— Makes it easy to know where to send messages

(#—[ Agency { Prefix { Primary BBS [ Secondary BBS
[ Santa Clara County Cities and Agencies
ﬁ[ American Red Cross [ AaRc [ wixsc [ waxsc
2 [ CAL FIRE VIPs - Santa Clara Unit { scu { W2XSC | WIXSC T ;
This information
Campbell, City of CBL W1IXSC WA4XSC . .
is also available
Cupertino, City of CUP W1XSC W4XSC
as a packet
Gilroy, City of GIL W2XSC W1XSC ..
notice in the

Hospitals (all SCCo) & MHJOC HOS W2XSC W1XSC
Loma Prieta Region LMP W2XSC W1XSC
Los Altos, City of LOS W3XSC W1XSC

B S —————— > S-S~ I e p-— YTy

https://www.scc-ares-races.org/freqs/packet-fregs.html
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 54
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Selecting a BBS

e Connect to the primary BBS whenever possible

e Otherwise, connect to your secondary BBS

e Otherwise, connect to whatever BBS you can reach
e Access frequencies

— EOCs should use 1.25m (220) whenever possible, because ...
— Most individual users will be on 2m or 440

e Action ltems

— Print out and keep a copy of the Packet Frequencies and BBS Listing
page in your go kit (maps cities to Tactical Calls to BBSs)

— Keep a copy of the equivalent packet notices in an Outpost folder
— Know your own primary and secondary BBS call signs!
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BBS Connect Names for AX.25 Packet Radio

Call Sign| AX.25 PUser Access BBS-BBS | Location

| WIXSC | W1XSc-1 [|145.750, 223620 433 570 | | Santa Clara Co Office Bldg (San Jose)
W2XSC | W2XSC-1 1145.730, 223.560, 433.590 Crystal Peak (South County)
W3XSC | W3XSC-1 [1144.310, 223,540, 433 450 Palo Alto

| W4XSC | WAXSC-1 [[145.690, 223.600%, 433.550 |223.600 |Frazier Peak (above Milpitas)
WaHXSC | WHXSC-1 [jvaries varies Training, events, backup

| W6XSC | WexXSC-1 JJvaries | varies | Testing, backup

https://www.scc-ares-races.org/freqs/packet-fregs.html

+ The AX.25 protocol uses an SSID (Secondary Station [Dentifier):
« The “-1” following the call sign... W1XSC-1

« Allows more than one device, or more than one service on a device, to
use the same FCC call sign on the same frequency

 The BBS mailbox function on all SCCo BBSs uses an SSID of 1

» To connect to your mailbox on an SCCo BBS using AX.25 packet radio, you

connect to:
W1XSC-1, W2XSC-1, W3XSC-1, W4XSC-1, W5XSC-1 or W6XSC-1

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 56
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Selecting a BBS in Outpost

» BBS setup for X5C WIXSC-1

e Setup >BBS ...

e The SCCo Installer includes
setups for all SCCo BBSs

e All SCCo-supplied setup _—

M ame I F'rumpts] Commandsz | nit Eummandsi F'ath]

BRBS Mame

wﬂ XSC_WIXSC-1 |

. Connect Mamey 1501
names Start Wlth ”XSC_” M]Santa Clara County ARES/RACES Packet
. System. Located in San Joge. JNOS.
e For the W1XSC BBS, you will _~— Freq: 145.750 :
BES Type
connect to W1XSC-1 s

(+ Let Outpost determine the BES and zet up the prampts
" Uszer defines the BBS prompts

e Then tune your radio to i e
 As8ARE BES
proper frequency from your  AA4RE BES with Tactical Call Customization
BBS frequency list

1 |XSC_Kantronics_KPC3-Plus

k. Apply
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CONNECTING TO YOUR MAILBOX
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Call Sign Determines “Login” and Mailbox

Setup > Station ID ...

e BBS “logins” are based on the call sign
used by the connecting station
— Defined by the TNC’s “mycall” setting

— Outpost sets this automatically based on Legal
information in Setup > Station ID... User Cal Sign: [WeXRL4

UserName: |Herman Munster

Message D Prefix: (3 Characters max)
e The call sign can be either an FCC or Tactia

i i [V Use Tactical Call for all BBS interaction
tactical call sign el erac

Station ID is W6XRL4 as XNDEOC

-

Identification I BBS Loginsl Signatures |

Current Profile: [Outpost

Tactical Call Sign: I XNDEOC

— FCCcall sign: W6XRL4 (Herman Munster) Addiional D Text: [xanagu EOC
v’ Tactical call sign: XNDEOC (Xanadu EOC) oo B

v Additional ID Text: where you are located

[ Show this form on startup

v Message ID Prefix: unique identifier

NOW ALSO REQUIRED!

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Tactical Call Signs

e Tactical call signs must be pre-defined before use

— Your City/Agency EC/AEC can request tactical call signs as needed
https://www.scc-ares-races.org > Packet BBS > How to Request Tactical Calls

e You can connect to any SCCo BBS using any valid tactical call
sign, but:
— You should only do so when assigned by your city/agency
— You should use the primary BBS for your agency
— You should only use another BBS if authorized by your city/agency

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 60
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P et e 0

CHECK IN

CHECK OUT

CHECK-IN/OUT MESSAGES
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Check-In/Out Messages

e Properly formatted Check-In/Out messages are important

Recipient can easily find them among other messages in the In Tray
They inform the EOC or other “net control” which stations are ready
They are part of DSW supervision

e General rules during field assignments

Check in and out using your assigned Tactical Call, not your FCC call
Check-in as soon as the station is reaay '

Check-out before shutting down the station using your Tactical Call
Always send as plain text messages

Always use [HandlingOrder] =“ R_”
e Handling Order = R (Routine)
Always follow the standard subject line format

e With specific check-in/out details for subject and message body
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Identification | BES Logins | Signatures |

Current Profile: [Outpost
Legal

User Call Sign: =

New I

User Name: [Herman Munster
Message ID Prefic [R| 4 (3 Characters max)
Tactical
v Use Tactical Call for all BBS interaction

Delete

Check-In/Out: PackltForms

e PackltForms includes a Check-In/Out message form
— Option for both check-in and check-out messages
— Handles FCC call signs and Tactical Calls

t| Submit via Email| Reset Form |

— Correctly formats the subject line and message body

= Station ID is WEXRL4 as XNDFS1

QO D 127.0.0.1:56732/form-2

Tactical Call Sign: IXNDFS1 j New I
Additional ID Text: [)(anadu Station 1
Delete I
Message ID Prefix. [Fg4 (3¢ max)
[~ Show this form on startup oK Cancel [

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Message number:

Your Call Sign:

Use Tactical Call: XNDFS1

FS1-1772P J
@checkIn O Check Out

<
WEXRL4 Name: Herman Munster i

Name: Xanadu Station 1

E FS1-1772P_R_Check-In XNDFS1, Xanadu Station 1 (PM:342)

File Edit Actions Window Help

Send |

Print | Save | Delete Close| Urg| Pwt | Bul N‘I

St PR p et Private Message

Bbs: (W1XSC-1

4

From: [XNDFS1

To.. [[XNDEOC@W1XSC

Subject: |FS1-1772P_R_Check-In XNDFS1, Xanadu Station 1

Check-In XNDFS1l, Xanadu Station 1
WEXRL4, Herman Munstex

L@, oo
e

e e

4
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10/2/2023

e What’s new!
— There are no longer scheduled rotating BBS outages
— You do not have to create your own message content.

— You will send a message form that is virtually handed to
you by viewing it on the instructions page.

— Visit scc-ares-races.org/pacpractice to get instructions!

e To participate:

— Check in any time during the week before 19:00 on the
day of the net

— The instructions are different each week
— Software will test your check-in for accuracy

Copyright 2023 Santa Clara County ARES/RACES. All rights reserve d.

Practice: Weekly SPECS/SVECS Nets
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CREATING A MESSAGE

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 65
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Creating Messages with Outpost

B outpost Packet Message Manager

w Setup Tools Forms Actions Help

PY Sta rt a neW message. ‘ New) Open I Archive .Delele Print | Searchl SendeeceiveJ Proﬁ]
— Press New - —

Local ID | Subj

xsceoc... XSCPERM
xsceoc... XSCPERM WIi1XS... 6PE-2... SCC;
Xsceoc XSCPERM  W1XSC-1 6PE-2... SCC|
XSCeoc. XSCPERM W1XSC-1 6PE-2... SCC
xsceoc... XSCPERM W1XSC-1 6PE-2... SCC
XSCeoc.. XSCPERM  W1XSC-1 ... SCC
1 B New Packet Message (PM:1246)

— Fill in all remaining fields

e Multiple source options
— Free-form plain text AThin

DO OO DR

e Supports TAB characters,
reducing the character count

Eile Edit Actions Window Help Popup Menu
Sendl Print | Save | Delete Closel Urg | Pvt | Bul NTSl 1l (1

— Cut and Paste from other RN e
. Bbs: [W1XsC-1
apps, like Word, Excel From: [XNDEOG
. . To...
— File> Open a F|Ie, then Subjed:lxND-1363P |

choose a .csv file

— Import text files directly into
the message form

e Press Send
— Message goes to Out Tray

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Outpost Message Window Details

e 03P _R_lellyDonut Request - Packet Message
Autofilled =

from Tools > Actions  Window Help  Popup Menu

Report Settings > _ ! =
Next Msg Number Print | Save | Delete! Close | Urg l Put | Bul ;NTS' i1 | | A ] Al
wate Message

— Autofilled from Setup > BBS

< Autofilled from Setup > Station ID
Filled in by you
<+— Filled in by you or autofilled by PackltForms

ndeoc@w2xsc.ampr.org D
subject: [XMND-1363F_R_JellyDonut Request

Flease pick up 1 dozen jelly donuts.

Thanks.
He rman|

Filled in by you or autofilled by PackltForms

67
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Message Prioritization

e Prioritize according to handling order, then date/time
— Handling order: Immediate, Priority, Routine
— Use Date/Time to prioritize between same handling order
— Ultimately, the served agency decides the order

Santa Clara County EOC Resource Request Form 213RR il
Message Numbers: | Origin: FS1-1779P 2 Destination: 1
Date: ©9/19/2022 Time: 19:44 Handling: (O Immediate (ASAP) (O Priority (<1 hr) @ Routine (<2 hrs)
ICS Position: Planning Section ICS Position: | |
T Location: County EOC : Location: | |
O Name: a Name:
A e PgEanbactdofeade - i e

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Standard Packet Subject Line

[OriginatorMsg#]_[HandlingOrder]_[Subject]

Example: XND-200P_R_Packet 3B Class Exercise Instructions

[OriginatorMsgit] [HandlingOrder]

* 3-character message prefix for the * 1-letter indicator as follows:
originator, a hyphen, followed by a * | =Immediate
message number. * P =Priority

* Qutpost adds a P suffix if it * R =Routine
generates the message number [Subject]

* Short description of the contents
of the message

» Autofilled by PackltForms or
entered by you

NOTE on Immediate mes
Immediate messages are usually are sent
by voice. But, if an Immediate has to

be sent via packet, send it PLUS send/receive asap, and also contact the TO: party by
a voice net (e.g. command net, message net) to let them know an Immediate
message is coming their way by packet.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 69
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Why The Subject Line Matters

e The receiving station must process messages according to
handling order, then date/time

— Must be able to easily scan the subject lines

e Which is most important? What is handling order?

Subject

PTS-834P Urgent: Need bulldozer
PTS-835P Water distribution
PTS-836P Barricades

e How about now?

Even a large In Tray is easily scanned

Subject

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 70
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Submit to Outpost | Submit via Email| | Reset Form Show Text Message
Message number: 6PE-618P
10y CheckIn () Check Out |
Your Call Sign: | Submit to Outpost | Submit via Email|  Show PDF | Show Text Message
[ Use Tacti
MESSAGE FORM  ovimnstens 2 s | ‘
e Submit to Outpost ' Reset Form | Show PDF | Show Text Message
Dae/i: Version: 8/17
Santa Clara County EOC Resource Request Form 213RR PIE:24
©7/23/2022 i i —
Message Ni
Submit to Outpost| Submit via Email Reset Form | Show PDF Show Text Message
Date: @6/21/
ICS Posi .
ICS Posit
s redicti WebEOC: 20190327
7| Locaton | catons Santa Clara OA Jurisdiction Status BiE 22
O Name: | o e Message N
ame: Submit to Outpost || Submit via Email | | Reset Form || Show PDF Show Text Message
Telephol Contactl{ Date: @6/21/
Subject: 1 = ICS Posit| -
[t..lnnmm.m | Santa Clara OA Shelter Status WebEOC: 20130814
T Location:| e
12 O Name: Message N - -
Message: lame: | ||~ | Submit to Outpost || Submit via Email || Reset Form || Show PDF Show Text Message
Contact |y Date: @6/21/]
L : Version: February 2018
Report Type: || + Location| Allied Health Status Report Short Form (pEoc-9) . ot
Message Ni - i - -
o q
Contact Inform| Name; ] Submit to Outpost| Submit via Email Reset Form | Show PDF Show Text Message
EOC Phone: Contact ||  Pate: 06/21/¢
Primary EM C{ | Report Type: I = Version: 20220129
Location:  Santa Clara County RACES -- Mutual Aid Request PIF: 2.4
Secondary EM | shelter i ocation: o
Name: e lo 7 Message Numbers: | Origin: RL4-2246P Destination:
Shelter Type: Name: P e
< Government ||/ Siatis: Contactlr  Date: ©6/21/2023 | Time:[hh:mn | Handiing: O Immediate (ASAP) O Priority (<1 hr) ~ © Routine (<2 hrs)
omcaStEtE|[Name: Report Type] ICS Position: RACES Chief Radio Officer v ICs Position: | |
Expected to O| = Address: 'Eamgmg g Location: county Eoc : Location: | |
Expected to G| | City: © Name: o Name:
S (ContactNarm Contact Info: Contact Info:
Zip: S Dhione. Agency Name: |
Latitude: Event/ Incident Name: I Number:
| Shelter Inforr{ | Facility Statu: | Assignment Duties, conditions, equipment, shift times
Green - Fully F
Red - Limited
Black - Impaire %f
Eaniti: mania | Amateur Radio Qty Role Position Preferred Type Minimum Type
<
[ m v || for example, checkpo..
Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. \ v
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Creating a PackltForms

e Select the form on Outpost’s Forms drop down menu
— Default web browser will start
— Form will be displayed with fields to be completed
— Note the items highlighted in RED... these are all required fields.

E Outpost Packet Message Manager .
File Edit Setup Tools Forms Actions Help

New | Open | A 1CS309 Communications Log fle:[ Outpost =l
" Folder List m XSC Check-In/Out Message
ot | [0 ecrocommn | ]
n Tra I
L 4 XSC EOC-213RR Resource Request R
. XsC 01 Submit to Outml Submit via Email ' Reset Form l Show PDF

XSC O#
XSC Al
MESSAGE FORM Origin Msg #: 2 6PE-2342P Destination Msg #: 3

XSCRA | sccolCS Form 213 (01/19/2022)  PIF 2.2

Generic Date ': Time (24nr) : Handling * :l ) Immediate (asap) O Frionstz' (<10 O Routine (<2 nr!
= i 6.
08/10/2023 “ This message requests you to °:
Deleted SR Take Action: () Yes O No
| Reply: O Yes, by O No
| 1cS Position: 7| Ics Position: © |
I e 1 Location: gl : Location: 9' 1l
— N o Name: : ‘ Name:
| Telephone #: Telephone #:
?ﬁbjact: | |
o 11 :
Copyright 2023 Santa Clara County ARES/RACES. Al righ | Reéference: 7 e.g. Nunber of earlier msg. 72
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Address it to whom?

e SCCo ARES/RACES Recommended Form Routing Cheat Sheet
e PackltForms now auto-fills most forms with the

— Handling Order

— To Location

— To ICS Position
Form Type } Handling To Location ** [ To ICS Position **
General EOC
1CS-213 Message Form Author defined Author defined Author defined

If “Priority” (Field 11) is: | Then “Handling” is:
Now | Immediate (ASAP)

EOC-213RR Resource Request High (0-4 hrs) | Immediate (ASAP) County EOC Planning Section
Medium (5-12 hrs) | Priority (<1 hr)

Low (12+ hrs) | Routine (<2 hrs)

Situation Analysis Unit

OA Jurisdiction Status Immediate (ASAP) County EOC Else: Planning Section

R g Mass Care and Shelter Unit

OA Shelter Status Priority (<1 hr) fo cocrl‘ltty Fn?;:na ed: Else: Care and Shelter Branch
THCOUIER 8% | Else: Operations Section
County EOC

https://www.scc-ares-races.org/ > Forms & Signs > Go Kit Forms

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 73
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Submit the PackltForm to Outpost

e QOperatorinfois filled in automatically
— Operator call sigh and name
“Sent” by “Packet”
— Date and Time (when Submit button is pressed)

e Click the Submit button to send to Outpost

Submit to Outpost | |Submit via Email |  Reset Form | Show PDF |
s y |

MESSAGE FORM Origin Msg #: 2 FS1-178@P Destination Msg #: °

SCCo ICS Form 213 (01/19/2022) PIF 22

Date ': Time (24hr) : Handling ° : O Immediate (AsAP) O Priority (<1 hr) @ Routine (<2 hr)

20:13 This message requests you to 6 :
Take Action: () Yes

09/19/2022
e e W Gl

[ €T Managerent | Operations . Planning T Logistics 1 Finance

Operator Use Only: 4

Sent:
How Received O) or Sent @ Operator Call Sign:  WEXRL4

O Telephone O Dispatch Center Operator Name: Herman Munster

O EOC Radio O FAX O courier

O Amateur Radio ® Other: Packet Date: {{date}} Time: {{time}}

74
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Submission Successful

e Form is transferred to Outpost; OK to close this form

C o O O 127.00.1:56732/form-7
The message has been submitted to Outpost. You can close this page.
MESSAGE FORM Origin Msg #: 2 FS1-1780P Destination Msg #: 3
SCCo ICS Form 213 (01/19/2022) PIF 2.2
Date 1: Time (24hr) : Handling °: O Immediate (45AP) O Priority (<1 hr) @ Routine (<2 hr)
09/19/2022 20:13 This message requests you to 5:
Take Action: () Yes O No
Reply: O Yes, by O No
ICS Position: 7 Planning ICS Position: ¢ Radio Operator
T Location: ¢ Xanadu EOC ; Location: ¢ Xanadu Station 1

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Message Progression

Did you see what happened?
File Edit View History Bookmarks Iools Help
® Incomp Iete Messag e; FS1-1780P_R_ICS213_sss X | XSCICS-213 Message % .
controls are grayed out, —_ O O wrootssrssfom-s
required f|e|ds in Red’ Submit to Outpost | Submit via Email | | Reset Form | Show PDF | D:muueu

g ray ba nner MESSAGE FORM Origin Msg #: 2 Fs1-1780P Destination Msg #: 3

SCCo ICS Form 213 (01/19/2022) PIF22

Date ': Time (24hr) © [ 540 (asaP) O Priority (<11 O Routine (<2 i)l

File Edit View History Bookmarks Iools Help
e Complete Message; Fs1-1780P R Cs212 53 x| wscics 213 Message x| +
controls are enabled, c o O D wrooserzoma
ready to send, st o Quspes ] Suit ottt e fnn] St 1)
green banner. MESSAGE FORM Orgin Msg #: 7 Fs1-17807 Destination Msg :

SCCo ICS Form 213 (01/19/2022) PIF22

naa.

LD‘atg ke Time (24hr) Handling 5- 0 lmm:qintg (AsaP) () Priority (<1h) @ Routine (<2 h)
o o

4

File Edit View History Bookmarks Iools Help
° Submitted Message; FS1-1780P_R_ICS213_sss X =
controls are removed; oot iR a e

displayed success status,
MESSAGE FORM n : 2 FS1-1784 stination i
purp|e banner. SCCo 1CS Form 213 (QI192022)  PIF 22 | T o FeL-azeee i

Date ': Time (24hr) - Handling ®: O Immediate (AsAP) O Priority (<1 i) ® Routine (<2 hr)

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

The message has been submitted to Outpost. You can close this page.
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Error During Submission

File Edit View History Bookmarks Tools Help

& G | @ 127.0.0.1:60300/submit-3 e & P2 B

A Something went wrong.

This information might help resolve the problem:

Opdirect isn't running, it appears.

Error: connect ECONNREFUSED 127.0.0.1:9334
{"method":"POST","host":"127.0.0.1","port":9334,"path":"/TBD"}

{"addon name":"SCCoPIFO", "addon version":"2.17", "message status":"new",

"MSG NUMBER":"XND-1194P", "operator call sign":"W6XRI.4", "operator name":"Herman
Munster", "TADDON_MSG_TYPE":"form-ics213.html",
"SETUP_BBS CONNECT NAME":"W1XSC-1", "emailURL":"/email-3",
"submitURL":"/submit-3", "saveURL":"/save-3", "subject":"XND-1193P_R ICS213 jhg"}

log file C:\PackItForms\Outpost\SCCo\logs\2019-09-05-server-60300.log

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved 77
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Correcting Submission Errors

. . Windows Taskbar
e |s Opdirect running?

— Opdirect interfaces PackltForms to Outpost

Opdirect EMS
Message Monitor

Initializing Opdirect EMS v3.6 cO01

Loading Profile "Outpost”
Starting up logging... passed!
- SRVO0O01: Ready, Listening on Port 9334

A SRVOODT: Server ready e T WBLR aNETE 102 WHSE g5 Lk PP RAR E

e Solution -
— In Outpost: Tools > Message Settings, Adv Tab;
M Automatically Start Opdirect...
— Restart Outpost. Verify Opdirect is running
— Press “Back” on web browser
— Click “Submit” button again

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Enter the “To” Address

FS1-1780P_R_ICS213_Replacement Generator (PM:354)

File Edit Actions Window Help Popup Menu
Sendl Print = Save | Delete Clnsel Urgl Pvt | Bul NTSH .”.I A]AI

e An Outpost message

W|ndOW appea rS' Private Message
. . Bbs: |W1XSC-1
containing a condensed | ... o
To... |IXNDEOC
an d fo rm atted m essage Subject: EFS1—1 780P_R_ICS213_Replacement Generator
e Subject lineis correctly |L58 e A
fO rm atted :ch;ﬂz g;éi—rma?]

la.: [09/19/2022]
1b.: [20:13]

e Enter the “To:” address |s.: weorom;

7.: [Logistics]

H H H 8.: [Radio Operator]
— More on this in a bit! Sa 7 [hety a1
Sb.: [Xanadu Station 1}
H o“ ” -
° 10.: [Replacement Generator)
CIICk Send 12.: [Generator has failed. Need a replacement of at least 5

KW as soon as possible.]

Rec-Sent: [sender]

CpCall: [WEXRLA4)

OpName: [Herman Munster]

Method: [Cther)

Other: [Packet]

OpDate: [09/19/2022]

OpTime: [20:47]

! /RDDON! v

Subject line and message text fields are locked. 463
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Press Send/Receive

e Message is in the Out Tray
e Press “Send/Receive”

e Messages will be sent if...
e message is from the currently configured user (Setup > Station ID), and
* message is being sent to the currently configured BBS (Setup > BBS), and
e message is not a DRAFT message

m Outpost Packet Message Manager = O X

File Edit Setup JTools Forms Actions Help

New | Open | Archive | Delete | Print | Search | SenaReceive | Profile: (SRR ~] a|A

XNDFS1 xndeoc@
o |

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Delivery Receipts

e Message Recipient

e Message Originator

File Edit View Actions Windows

m DELIVERED: FS1-1780P_R IC5213 Replacement Generator (PM:349)

Help

ety

— When you receive a message, Outpost generates a delivery receipt

— Receipts are sent during the same Send/Receive session that retrieved the
message

— Receives receipt with Subject line: “DELIVERED: <original subject>"
— Message contents: the date and time downloaded by Outpost by recipient
— Eliminates the need to ask “Did you get my packet message?”

Print

Reply | Rep Forwar

dI Archive Delete CInseJ

To

Bbs:

From:

Subject:

Private Message

wixsc-1
XNDEOC@w 1xsc.ampr.org
XNDFS1@wixsc.ampr.org

Rec'd: 9/19/2022 19:29

DELIVERED: FS1-1780P_R_ICS213_Replacement Generator

Your message was delivered to:
xndeoc@wlxsc.ampr.org at 9/20/2022 20:27
xndeoc@wlxsc.ampr.org assigned Msg ID: XND-12Z&P

ud R JES P2

Sent 9/19/2022 19:24

121
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ADDRESSING RECAP

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 82
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Top 5 Addressing Take-aways

5. Addresses within the SCCo packet network use the standard Internet-style
username@domain address format : usercall@bbscall.ampr.org
examples: W6XRL4@w2xsc.ampr.org
XNDEOC@w4xsc.ampr.org

4. Three different addressing formats for sending messages:
To: WeXRL4@w2xsc.ampr.org ... Full address always works!
To: W6XRL4@w2xsc ... At least always add the bbscall sign
To: W6XRL4 ... Do not use this shortcut

3. Always send to the user’s Primary BBS, unless
a) that BBS is down (then, use their Secondary BBS), or
b) that user cannot reach his/her primary BBS (bad location), or
c) you are told to use a different BBS

2. When sending from email to a packet address, send as a plain text e-mail

Read and understand the Packet Network Addressing Guide!
http://www.scc-ares-races.org/data/packet/packet-addressing.html

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved
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e Quick Reference
e Network Types

e Sending Private Messages
— Within our network
— To other networks
— From other networks

e Sending NTS Traffic
e Sending Notices
e Sending Bulletins

Complete Addressing Guide Available Online

Santa Clara County ARES/RACES

Home Operations Data>Packet Training and Events Reference FAQ September 19, 2022

Packet Network Addressing

TOC | QuickReference | NetworkTypes | Private Messages | NTSTraffic | Bulletins

Table of Contents

+ Quick Reference
© Sending TO a Call Sign on any Santa Clara County BBS
« Network Types
o AMPRnet
© BBS Network
o Winlink 2000
© Internet E-mail
+ Sending Private Messages (SP)
o Sending Private Messages WITHIN the Santa Clara County Network
o Sending Private Messages TO Santa Clara County Users
= Sending Private Messages TO Santa Clara County Users FROM the AMPRnet
= Sending Private Messages TO Santa Clara County Users FROM the BBS Network
= Sending Private Messages TO Santa Clara County Users FROM Winlink 2000
= Sending Private Messages TO Santa Clara County Users FROM internet E-mail
= Sending Private Messages TO Santa Clara County Users FROM SMS/Text
o Sending Private Messages FROM the Santa Clara County Network
= Sending Private Messages FROM the Santa Clara County Network TO Any AMPRnet User
= Sending Private Messages FROM the Santa Clara County Network TO Any BBS Network User
= Sending Private Messages FROM the Santa Clara County Network TO Any Winlink 2000 User
= Sending Private Messages FROM the Santa Clara County Network TO Any Internet E-mail User
= Sending Private Messages FROM the Santa Clara County Network TO Any SMS/Text User
« Sending NTS Traffic (ST)
o NTS Address Format
o NTS Traffic Handling
o Additional NTS References
+ Sending SCCo Notices
o Notice Address Format
o Notice Areas
© Reading Notices
« Sending Bulletins (SB)
o General Bulletin Address Format
= Categories
= Distributions
© Bulletin Areas
o Reading Bulletins
o City-specific Bulletins

S =
R e N s e

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Distributing network-wide messages

NOTICES AND BULLETINS

Copyright 2023 Santa Clara County ARES/RACES. All rights reserve d 85
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Notices and Bulletins: Overview

Bl

e Bulletins are messages intended for a broad audience
— They are a great way to get information out to everyone
— Better than a mailing list; no need to know all the desired addresses
— When configured, Outpost will take care of retrieving them for you

e The SCCo BBSs support two types of bulletins
— SCC Notices are a special type of bulletin specific to Santa Clara County BBSs
e Only distributed to SCCo BBSs (W*XSC)
e Simple to address
e SCCo uses 3 special Notice categories

— General bulletins are used for wider (local to worldwide) distribution
¢ Organized by general categories (e.g.: “equake”, “ARES”), and
e Distribution ID defining how widely it is distributed (e.g.: “XSC”, “BAY”, “NCA”, etc.).
¢ Qutside the scope of this class (will cover in the Packet Type 2 Class!)

e Regardless of the bulletin type, when configured in Outpost, they will
automatically be downloaded

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved. 86
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SCCo Notice Areas N O TI CE

e SCCo ARES/RACES has four special notice categories:

— Xxscperm
e Used for notices that do not expire

e examples: standard county procedures
— Xscevent

* Notices posted here automatically expire after 8 days

. . . . . - . .

e examples: Drills, public service events, incidents, other activations
— Xsctest
— allxsc

e Where you can write city and jurisdiction notes

e Notices posted here automatically expire after 8 days

L .

e Advantages
— Limits on-air time required to check bulletins
— Focuses readership so important information is not missed
— Outpost only downloads a notice once
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e The SCCo Packet Installer
pre-configures Outpost to
download SCCo notices

— XSCPERM
— XSCEVENT

e In Outpost:

— Setup > BBS, Retrieving Tab
— Check “Retrieve Bulletins”

BBS setup for XSC W1X5C-1

Outpost is Pre-Configured for SCCo Notices

Name] Prompts | Commands | Init Commands Relrieving] Path |

Retrieve these Messages
[v Retrieve Private Messages
|~ Retrieve NTS Messages

[v Skip NTS Messages that| send
[~ Skip Bulletins that | send

7 Retriave Bulleﬁns@ - Keep messages on BBS; do

" All new Bulletins

not delete after retrieving

" Selected Bulletins

Enter as a list of
filter items (i.e.: QST
KEPS, ARES

Custom Retrieval A XSCPERM
Enter as a list of LA
JNOSBBS Areaand | yscEvVENT

List commands 1A
— Check “Custom Retrieval” e ™~
— Custom Retrieval:
A XSCPERM (Area) 0K | Apply ‘ Cancel
LA (List All)
A XSCEVENT (Area)
LA (Li
LLXSC
LA (List All)
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Using City Bulletins

Setup

Setup > BBS > Retrieving

Change to your city’s three char prefix

* Custorn Retrieval L XSCPERM
Enter as alist of JNOS |7 7
BEAE B oo

TR
A ALLXSC
; L> XND

(ex: “XND”, “SIC”, “MTV”, etc.) ==

NOTE: only one City entry is allowed.

Create, send a city bulletin

Start a new message
Click the “Bul” button

B XND-759P_R_Donuts delivered - P~ __. .ncssage

findow Help

Print | Save | Delete Close| urg| Pvt | Bul NTSl‘

Bulletin Message

From: |XNDEOC
xnd@xsc

Bbs: [W5XSC-1 i

Address it to “xnd@xsc” =
Enter your message and click Send

Addressing it to @xsc distributes
to all XSC (Santa Clara County) BBSs.

See the details here...
WWW.scc-ares-races.org/data/packet/packet-addressing.html#bull-city

Copyright g%tgs#

Subject: |XND-759P_R_Donuts delivered

To: Xanadu Field teams,
All requested donuts have been delivered to the EOC.
XND Logistics is working to get them distributed.

Signed,
Herman WEXRL4

anta Clara County ARES/RACES. ATl rights reserved.
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EVENT DOCUMENTATION
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ART,
0‘}——\!"64,)

Accuracy and Completeness Ay

FEM

Excerpts from the FEMA | Office of Inspector General report titled “Summary
of Key Findings of Fiscal Year 2016 FEMA Disaster Grant and Audits”

— “Over the 7-year period, FYs 2009 to 2015, we found 51.64 billion, or 15
percent, in questioned costs out of the 510.9 billion that we audited, which we
recommended FEMA disallow as ineligible and unsupported costs.”

— “In fiscal year 2016, we found 5S155.6 million, or 23 percent, in questioned
costs out of the 5686 million that we audited, which we recommended FEMA
disallow as ineligible and unsupported costs.”

In cases where FEMA payments were made and claims later disallowed,
recipients were required to repay these payments, with audits sometimes
taking place years later.

Because our documentation could be a used as part of the City’s justification
for either an expense reimbursement or cost recovery request, ensuring the
accuracy and completeness of what we submit is critical.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.
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Archiving event documentation
Introduction

e The job is not done until the paperwork is complete... and
submitted.

— Every scrap of paper used during an activation is part of the event or
incident and goes to the Documentation Unit (or your Supervisor)

¢ |t must be legible (print)

e Use one side only
— These are legal documents that may be needed to defend decisions
— Most of this documentation is ‘discoverable’
— Ifitis not in the documentation, then it did not happen

— Some documentation is specifically created after the event or
incident, such as the After Action Report

e And, all this applies to our packet operations
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Archiving event documentation
Introduction

e During a Packet Deployment, you will produce the following:

1. 1CS 214-SCCo Unit Activity Log
ICS 309-SCCo Communications Log (if participating on a voice net)
All third party sent & received PackltForms and plain text messages
All sent and received operator to operator packet messages
ICS 309 Communications Log (packet)

o A W

Any Form 1 / hand-scribbled / sticky notes, documentation.

e Whether it be an exercise or a real activation, when your shift is over,
your supervisor will provide instructions on wrap-up tasks that need to be
done. These can include:

— Submitting all documentation (to whom and how)

— Preparing the packet station for the next use, including archiving your
shift or the event
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Archiving event documentation
ICS 309 Communications Log (packet)

File Edit Help

1. Create the ICS 309 Comm Log
a) From Outpost, Tools > Report Settings, 3rd

BmldDataSetl Prlnl‘ Exit |

Operational Period

R ics 309 Comm Log Builder

Activation Number Date/Ti

CUP-23-16T 8/10/2

Incident Name

|(]8/(]112023 00:00 to 08/08/2023 19:00
Radio Operator Name

tab, “ICS309.” Enter all fields.

|Prospect *Heights" Earthquake
Station ID / Call Sign

|Herman Munster

b) Select Forms > ICS 309 Comm Log.

c) Select Period Tab. Select Range, set the
From: and To: to the date/time range for when

Repaorting Period

" Today (8/10/2023 21:31)
" Since last report run (8/7/2023 1
" All (2/412019 15:45 to 8/10/2023

[wexrL4

Period | Cuntent] Sort| Layout | Oulpull e-SJgﬂature]

FromDate: | 3712

9:14) 5
21:31) From Time: [12:00

your shift (or event) occurred. & Range ToDate: [ 102
d) Select Content Tab. Do not exclude anything! i 8
e) Select Output Tab. Check output options. D oo s
NOTE: If you do not have a printer, then try the 3 DN M 20145 -80S0 @02 KA1, S0
default Microsoft Print to PDF printer. P omm me mne e o o
f) Select the Signature Tab. = B T
g) Press Build Data Set, then press Print. 4 =
h) Sign any paper-printed ICS 309 form. A TSI S 5 RN
i) Deliver this report to your supervisor.
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Archiving event documentation
Printable Message Listing

2. Create a printable message listing

a)
b)

d)

e)

From Outpost, File > Save All.

This will create an Ascii-formatted file
of all messages in the current folder
with a Page Break between each
message. Use meaningful file names.

Repeat this step for any other folder
where event messages were stored.

Later, this file could be printed to
generate one message per page. Or,
because the messages are in a .txt
file, any message could be copied
and pasted into another note pad,
and printed for reference.

Deliver this file to your supervisor.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

B Test-data.txt - Notepad
File Edit Format View Help
Subject: Packet Tutorial URL

FYI, excellent 18 part (!) packet tutorial at 3§
http://www.choisser.com/packet/s

From: AABWK
To: ALL
Sent: 6/29/2007 08:40

Subject: Welcome to K6FB packet mailbox

Welcome to the K6FB packet mailbox. All are welcome
K6FB is located on Castle Rock Ridge, near the state
We have a digipeater (K6FB-1), mailbox (K6FB-2), andi
Please use and enjoy.

- de AABWK, K6FB packet sysop b

Iy :
From: knépe@wlxsc.ampr.org ]
To: KNGPE

Sent:

8/29/2021 13:02
Subject: 6PE-1738P: line splih test 4

This is line 1 that contains a lot of text that is n

~sciateiead s _ahout ateacsilieamaiuadisne the chag .of
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Archiving event documentation
Message Archive

3 Create a Message Archive EOutpostPacketMessageManager
' File| Edit Setup Tools Forms Actions Help
a) From Outpost, File > Export, then ?MZQ CC“‘I"; Print | _SendReceive IProﬁﬁ
ave As... trl+
select “All Folders® (for your entire Save A, No Headers..
s stem) Save All.. [ To | BBS
y ' Export > Allfolders... ;gl
1 1 Import This Folder...
b) Use meaningful file names. T , [P
. s I nbpe@w1. -
c) The Export process will create an Snf S . KNPE WiXSC
. . Delete All Messages B
ALL K6FB-2
Outpost Archive File (.oaf). -y I pediy
d) This file later can be imported back e

into Outpost to restore the archived
messages to their original folders.

e) Deliver this file to your supervisor (email or USB).
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Archiving event documentation
Reset Outpost for the next event

4. Reset Outpost for the next event

STOP! Do not proceed until you have created a
~  Message Archive>All Folders first.

STOP! Do not proceed until you have

permission from your supervisor.

a) If not already done, set up the SCC Notices message folder
a) Tools > General Settings, Start tab.
b) Set the name of one of the folders to SCC Notices.
c) Move or drag all SCC Notices into this folder.

b) Export (backup) the SCC Notices folder:
a) click on this folder. Then File > Export, select This Folder
b) Give it a name, like “SCC_Notices-yymmdd”. Press OK.
c) Verify that all messages (6 today) were exported.
d) FYI... your file is in the C:\SCC Packet\archive directory
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Archiving event documentation
Reset Outpost for the next event

4. Reset Outpost for the next event (continued)

c) Delete all Outpost messages:

All your files are deleted.

d) Restore the SCC Notices:
a) File > Import, select the file, press OK

e) You now have a clean system for the next event or incident.

f) Inform your supervisor that this task is complete.

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved

a) Go to File > Delete All Messages, answer Yes at the prompt.
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OUTPOST TIPS
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Resend option

You did what?!!?

* You just sent a message, but ...

— it was addressed incorrectly, or
— it was sent to the wrong BBS, or
— you forgot to include all recipients, or

— it was incomplete, or

— it was the wrong message, or

— any number of other problems!

And, you don’t want to type it all back in! What now?
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Resend option — Text Messages

Outpost’s Resend option lets you resend a message previously
sent. For Text Messages...

R 6PE-1754P - outpostpm test (PM:1849)
b From the Sent fOIder[ File Edit View Actions Windows Help

open the message Print | Reply | Reply Close
. . Private Message Rephito Al
e Click on Actions > Resend... we v i
. . to Unrea
choose either option o e r— ] I’
e The message is opened in Subject GPE-T  Add Address New Message ID !
H his s @ e Change Route iy
edlt mOde' = : Copy to les213mm format 5
e Make whatever changes povered by ol ]
Font...
you need to make, then A
e Press Send, then | e __J

Send/Receive as usual.

NOTE! If you select Resend, Same Msg ID, then manually change the

Message |ID -###P to -###R for Resend. This ensures no duplicate message
confusion, =~ Te———
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Resend option — PackltForm Messages

Resending PackltForm Messages depends on your option.

For Same Message ID...
¢ From the Sent folder,

Forms Actions Help

ive | [ Send/Receive
Send Only

Receive Only

single-click on the message to

highlight it (not open it)
* Select Actions > Open enhanced |
msg as text §
e Once the text version of the form ¢
opens, click on Actions > Resend...
choose Same Message ID

New Message
Open a Message
Open enhanced msg in client

Open enhanced msg as text

e e e - -

Force one-time bulletin retrieve

e The PackltForm will open as a new copy of the message in the Browser,

just as if it was a new message for editing.
Make other changes and continue as usual.

NOTE! If you select Resend, Same Msg ID, then manually change the
Message ID -###P to -###R for Resend. This ensures no duplicate message

Q
confusion. .

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Ctr+O

Ctrl+F

BPE-1743P R MuniStat
B6PE-1742P_R_MuniStat
6PE-1740P: URL testing
6PE-1738P: truncation td
6PE-1736P: trincation teg
6PE-1731P_R_MuniStat
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Resend option — PackltForm Messages

Resending PackltForm Messages depends on your option.

For New Message ID...
e First get the Next Message Number e
Global Variables
_ |n OUtpOSt, TOOIS > Report Settings NeﬂMessa ndependent of profile settings
Repad avied this profile

— Note the Next Message value. This is T o porino CRoone Corge

the number to use. Do not change it! city: [City of Cuperting
L N ey e

e Then, from the Sent folder, single-click
on the message to highlight it (not open it)

e Select Actions > Open enhanced msg as text

e Once the text version of the form opens, click on Actions > Resend...
New Message ID

e The PackltForm will open in the Browser.

e Manually replace the PackltForm Origin Message Number with the
number you noted above.

e Make other changes and continue as usual.
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FIELD PACKET DEPLOYMENT
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Putting it all together

1. First Shift... when assigned to establish a station

2. Initial station setup... equipment check-out, and check-in
3. Packet Operations... managing the message flow

4. Incoming Shift Change... if you are relieving someone else
5. Outgoing Shift Change... if you are being relieved

6. Securing Operations... when directed to shut down
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Field Reference

Amateur Packet Radio
Field Reference, Type lll

For SCCo RACES Responders

September 2023

)

9 CHECK-IN, CHECK-OUT MESSAGE .......
10 RECOMMENDED FORM ROUTINw CHEAT SHEET.

Table of Contents :
1  'QUICK REFERENCE....ccccininnsimiaimamsinmmsiimimis g
2 INTRODUCTION ...iccuiusuinssiinssssiusuisissssssinsnsssssasssasins svisssnsasin
2.1 PURPOSE o ciuovisssvmmissssnisvssisssisnsssssiasivisessssisssssivvasisvasios g
2.2 HOW TO USE THIS HANDBOOK........veeueeesaeeseeenseeeseersasersnnenns 1
3 PACKET OPERATOR CHECKLIST
4 PACKET STARTUP PROCEDURE.......cccoovmrurssnersanssansssnnnns
5 CLIENT SOFTWARE....
6 PACKET MESSAGING.
6.1 PACKET MIESSAGING BASICS.....vveecuieeeeeeeeeecieeeraeeeeceneeeenaens ‘
6.2 FREE FORM (PLAIN TEXT) MESSAGE ...c..cueeeuircnciennesreereneenens il
6.3 SENDING A SPREADSHEET .CSV FILE «.cvvveeeeeeeeeeeeeeieeeeeeeaeeenneees ; —
7 MESSAGE ADDRESSING.........ccconmmnmmmmenisnmsmssnssssmssss s ¢
8 STANDARD SUBJECT LINE FORMAT .....ccccocevrerrrareneerennes 1

11 ARCHIVING EVENT DOCUMENTATION .......ccccomuneninnininans .!
11.1  CREATE THE ICS 309 COMMUNICATION LOG ..o g
11.2  CREATE A PRINTABLE LIST OF YOUR MESSAGES.........vcovereerennsens §
11.3  CREATE AN ARCHIVE OF YOUR MESSAGES.......c.euvevecremeereneeneenes E
11.4  RESET (CLEANUP) OUTPOST FOR THE NEXT EVENT...vverveenesnsenns ,;

j
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Final Assignment

e Online Class Evaluation
— Loginto https://www.scc-ares-races.org/activities/events.php

Click “Submit Class Evaluation” in Events

Home

Log Out
Activities Home

SCC ARES/RACES Home
Comments/Bugs
Events

List Events By Date

List Events I Joined
Create a New Event
Modify an Event

Delete an Event
List/Print an Event Roster

Log Event Participation
Submit Class Evaluation
My Profile

B e

Copyright 2023 Santa Clara County ARES/RACES. All rights reserved.

Calendar of Events

e

Show: Current events (® Past events ()  Event Descriptions

Packet Operations Type 1II, Part B

Date: Start: Type: Creq
10/07/23 9:00 AM County Training Yes

Course Details: Click here to visit the course description and downlo
ele...

Introduction to Emergency Communications - NIGHT CLJ_

Date: Start: Type: Cre
10/18/23 6:00 PM County Training Yes

Congratulations! You just got your Ham Radio license and are anxiil.l

concepts that yo...

— Submit your evaluation as soon as possible... after 1 week, the form
will no longer be available for this class!
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Homework

And now, for something completely different...

e Please sign up for the Monthly Packet Message Passing Exercise planned
for Wednesday 18-Oct-2023.

e These exercises simulate participating in a real event as an experienced
county packet operator who has been assigned for mutual aid support for
Xanadu County and City.

e You will be asked to pass at least two 3rd party messages in each direction
(PacketltForm) and at least two operator-to-operator messages in each
direction.

e The exercise lasts for one week, starts at 09:00 on Wednesday 18-Oct-
2023 and ends a week later on 25-Oct-2023 at 17:00. A zoom debrief
follows.

e Please register for this event here... https://www.scc-ares-
races.org/activities/eventdetail.php?id=1371.
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Thank You!

Please complete the Course Evaluation
on or before next Saturday 8-October!

Please complete the Assignment
on or before Wednesday 25-October!

If you have questions or feedback about this or other training activities,
you can join our Training discussion group.
https://scc-ares-races.groups.io/g/packet

Make sure you’re signed up for the next part:
Packet Type Il

Questions, comments, suggestions?
kn6bpe@arrl.net
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